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Information in this manual is subject to change without notice. This manual (“Manual” or “Documentation”) and the
software (“Software”) described in it are copyrighted, with all rights reserved. By using this Manual and accompanying
Software, you, the end user, agree to the terms set forth in the License Agreement.

Copyright

Under the copyright laws, this Manual or the Software may not be copied, in whole or in part, without the express consent
of CheckMark Inc. (“CheckMark Software”), except in the normal use of the Software or to make a backup copy of the
Software for your own use. The same proprietary and copyright notices must be affixed to any permitted copies as were
affixed to the original. This exception does not allow copies to be made for others, whether or not sold, but all of the
material purchased (with all backup copies) may be sold or given to another person. Under the law, copying includes
translating into another language or format.

Federal copyright law prohibits you from copying the written materials accompanying the Software without first obtaining
our permission. You may not alter, modify or adapt the Software or Documentation. In addition, you may not translate,
decompile, disassemble or reverse engineer the Software. You also may not create any derivative works based on this
Software or Documentation. A derivative work is defined as a translation or other form in which the Software may be recast,
transformed or adapted.

Limited Warranty on Media and Replacement

If you discover a physical defect in the Manual or in the media with which the Software is distributed, CheckMark Inc. will
replace the media or Manual at no charge to you, provided you return the item to be replaced with proof of purchase to
CheckMark Inc. or a CheckMark Inc. dealer during the 60-day period after you purchased the Software.

All implied warranties on the media and Manuals, including implied warranties of merchantability and fitness for a
particular purpose, are limited in duration to 60 days from the date of original retail purchase of this product.

EVEN THOUGH CHECKMARK INC. HAS TESTED THE SOFTWARE AND REVIEWED THE DOCUMENTATION,
CHECKMARK INC. MAKES NO WARRANTY OR REPRESENTATION, EITHER EXPRESS OR IMPLIED, WITH
RE-SPECT TO THE SOFTWARE, ITS QUALITY, PERFORMANCE, MERCHANTABILITY, OR FITNESS FOR A
PARTIC-ULAR PURPOSE. AS A RESULT, THIS SOFTWARE IS SOLD “AS IS”, AND YOU THE PURCHASER ARE
ASSUMING THE ENTIRE RISK AS TO ITS QUALITY AND PERFORMANCE. IN NO EVENT WILL CHECKMARK
INC. BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES RESULT-
ING FROM ANY DEFECT IN THE SOFTWARE OR ITS DOCUMENTATION, EVEN IF ADVISED OF THE
POSSIBIL-ITY OF SUCH DAMAGES.

The Warranty and remedies set forth above are exclusive and in lieu of all others, oral or written, express or implied. No
CheckMark Inc. dealer, agent, Consultant, or employee is authorized to make any modification, extension, or addition to this
warranty.

Some states do not allow the exclusion or limitation of implied warranties or liability for incidental or consequential
damages, so the above limitation or exclusion may not apply to you. This warranty gives you specific legal rights, and you
may also have other rights which vary from state to state.

Trademarks

CheckMark Inc. and MultiLedger are registered trademarks of CheckMark Inc. All other references are trademarks of
their respective owners.
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Chapter 1
Getting Started

CheckMark 1099 helps centralize all your 1099 filing needs. With this program you can
print or even e-file all forms needed for filing 1099-MISC, 1099-DIV, 1099-INT, 1099-S,
and 1099-R forms. The program has the option to print these forms on a pre-printed 2-up
form or a blank sheet.

Before starting the set up of your company and recipients, please read through this manual.
It covers general setup and 1099 requirements, as well as how you can receive additional
support directly from Checkmark, Inc.

System Requirements

CheckMark 1099 can be installed on a computer running either Macintosh or Windows
operating systems. This software is a single-user application and not designed for multi-
user access of the data files. DO NOT install the application program on a server. Install
the program locally on the user’s hard drive even if you save the data on a server.

Users will need to have a computer running an operating system of either Windows 7 or higher
including Windows 10, or Macintosh OS X 10.6 or higher including El Capitan.

Along with a compatible printer, the latest version of Adobe Reader is also required to
properly print certain forms from the program. You can download a free copy of
Adobe Reader from Adobe’s website at www.Adobe.com.

Whichever operating system you choose, a working knowledge of the operating system
is essential. For more information about the basics and navigation of your operating
system, see the user manual that came with your computer.

Software and Patch Updates

Each year the program is issued with the latest 1099 Forms as well as added features.
Program patches are released as needed throughout the year for the current version of
the software. Patches are available online at www.checkmark.com. Hard Copy CDs
can be purchased by calling the sales department at 800-444-9922.

Renewal notices are sent out each year, in the fall, announcing the next update.
Updates must be purchased each year to receive support and the ability to install
patches for changes.




How to Get More Help

This manual covers general set up and reporting. There may be items that are
specific to your company that are not addressed here except in general terms. For
these times, CheckMark, Inc. offers additional support.

Only registered users can receive technical support so please, take a moment and
read the License Agreement, fill out the Registration Card and send it in.

Support is offered via internet submission, E-mail, fax or telephone. Whenever you
contact support, have your customer number OR product registration number
available. It is important that you are at your computer with CheckMark 1099
running when speaking with support to best resolve your question/problem.

Before Contacting Support/Other resources

Check for latest version

Users with internet access can make sure that they are up-to-date as often as they
wish by selecting Check for Updates under the Help menu in the program. If
necessary, download and install the latest update (may require purchase if not using
the current year’s version).

1099 Manual

Users can access the 1099 program manual from the Help menu while in the
CheckMark 1099 program. An updated manual is included with each update.

Online Knowledge Base

Users with internet access can reference the online Knowledge Base for answers to
common questions. You can access the Knowledge Base directly from the
CheckMark website at www.checkmark.com.

Contacting CheckMark

For questions regarding the 1099 software, you can choose one of the following methods to
request technical support:

Online at: http://www.checkmark.com Click on support and select Request Support
By Phone: 970-225-0387

Mail: CheckMark, Inc.
323 West Drake Rd. Suite100
Fort Collins, CO 80526
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Chapter 2
Installation and Basic Use

Installing CheckMark 1099

Macintosh Installation

1. Close all programs and disable any anti-virus software.

**For CD Installation**

2. Insert the CheckMark 1099 CD-ROM into your computer’s drive.

3. When the CD icon appears on the Desktop, open by double-clicking it, then double-
click the CheckMark 1099 installer.

4. Follow the on-screen instructions to complete installation.

**For Download Installation**

5. Click on the link provided to download. After the download is complete, double-
click the download file.

6. Follow the on-screen instructions to complete installation.

The default install location on the hard drive for CheckMark 1099 is: Macintosh
HD\Applications\CheckMark\1099\(year). The (year) represents the current calendar year.

Install the program on the local drive.




Installing CheckMark 1099

Windows Install

1. Close all programs and disable any anti-virus software.

**For CD Install**

2. Insert the CheckMark 1099 CD-ROM into your computer’s drive.
3. The Installer will start automatically.

If the installer does not start automatically after a minute, click your Start menu and
then select Run.

Type in the path and filename in the Run box. That would be the drive name, colon
(2), backslash (\), Filename. For example: D:\setup. Then click Ok.

4. Follow the on-screen instructions to complete installation.

**For Download Install**

5. Click on the link provided to start the download. After the download is com-
plete, Choose Run or Open.

6. Follow the on-screen instructions to complete installation.
The default install location on the hard drive is
C:\ProgramFilees\CheckMark\1099\(year). The (year) represents the

current calendar year.

It is recommended to install the program on the local hard drive.
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Opening CheckMark 1099: New User

1.

Open the CheckMark 1099 application. You can use either the shortcut or alias
that was created or go to the CheckMark 1099 folder that was installed and
dou-ble-click the CheckMark 1099 application file.

The first time you open the program the welcome screen appears. This screen
provides useful information regarding the set up of Security, Customizing
screens and fonts and accessing the Manual.

Click the Print button to print out this information.

4

Welcome

" Welcome to

CheckMark 1099 for 2017

Thank you for purchasing CheckMark 1099 for 2017!

Please read the information below before continuing.

SECURITY

CheckMark 1099 encourages you to setup a Password to protect your private information. You can
manage User Accounts by selecting 'Admin' from the 'Tools' menu in the Main Menu. Click the 'Add User'
button to enter a Username and Password. Once you've setup a User Account, you will be prompted for your
login information the next time you use CheckMark 1099.

The first User Account you setup will be given Administrative privileges, allowing you to manage User
Accounts, Backup and Restore your information, and Edit Printing Formats. After you've setup an
Administrative User Account, you may then setup other User Accounts with or without Administrative

privileges.

Print Message

Copy Message

Important: It is recommended that you set up a password to protect your
private information. For information on setting up passwords, See “Setting up
Users and Passwords” on page 19.
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Opening CheckMark 1099: Upgrading Old Files

The information will be stored in a database that is created the first time you open
your previous files. the default location is:

Macintosh: HD\Documents\CheckMark\1099\(year)
Windows: C:\Documents\CheckMark\1099\(year)

1. Open the CheckMark 1099 application. You can either use the shortcut or alias that
was created or go to the CheckMark 1099 folder that was installed and double-
click the CheckMark 1099 application file.

2. If you have a previous 1099 database from a prior year, the program will ask you if
you want to import the Company and Recipient information.

3. Click Yes to continue. Enter the Username and Password from the prior year,
if requested.
-
CheckMark 1099 Login =22

ChecklVark”

1099 Software

Name |

Password

Execute Login Cancel Login

4. A pop up window asks if you want to clear out the prior amounts. Click Yes to
zero out amounts and continue or No to retain the prior year’s amount information

S. If you clicked Yes, you’ll be notified once the data is successfully imported.
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Database Manager

CheckMark 1099 stores company data in a database. When initially opening CheckMark
1099, a database named CheckMark_1099 Database_[year] is created.

If you complete 1099 forms for only one company, this is probably the only database
you will need.

However, if you process forms for more than one company, you will need to choose one
of the following options to manage your companies correctly. You can either store all of
your company files in the same database, or you can create separate databases and store
individual companies in them.

Storing Multiple Company Files in the Same Database

Each database can contain multiple companies. The advantage of storing all of your different
company files in one database is that when you Backup Database, Restore DataBase, Close
Database, or advance to a new year, all companies stored in that database will be backed up,
restored, closed or advanced to a new year at the same time, saving you time.

Storing Company Files in Separate Databases

The advantage of storing each of your company files in separate databases is that you have
more control over where your database is stored on your computer, as well as when you
want to Backup Database, Restore Database, Close Database, or advance companies to
a New Year.
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Using the Database Manager

Choose Database Manager from the File menu.

Database Manager

1099 Year Database Name Help
* 2017 CheckMark 1099 Database

Path /Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db
* currently open

Create New Database Add Database to List Find Databases

Rename Database Move Database Remove from List

Close Database Manager
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Create New Database

This option allows you to create and save a new database in any location you wish. Keep
in mind that each database can store multiple companies.

1. Click Create New Database.

2. Enter a Database Name and Payroll Year. Click the Browse button to select
a new location to save the database.

Create Database

Database Name CheckMark 1099 Database (Don't include year in name)
1099 Year 2017

Directory /Users/kristifisher/Documents/CheckMark/1099/2017/ Choose Directory

Path /Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db

Cancel

3. Click Create Database to save the new database.
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Add Database to List

This button allows you to add an already-existing database to the list. For example, if you
copied a database from another computer and the Database Manager does not list this
database, you can choose Add Database to List and browse to that location to update the
Database Manager’s list.

1. Click Add Database.

An Open dialog box appears

o Add Database to List
e =) = B 2017 S
Favorites 7 1095 > B 2017 > |1 _Configuration >
E Al My Fil B 1009 L [ _Backups »
AL Multiledger > | _Reports >
¢ iCloud Drive [ Payroll > [ R CheckMark...se

7™ Applications
= Desktop
@ Documents
© Downloads
Devices
[ Kristi Fisher's iBook G4
; Macintosh HD

[} KINGSTON a
Tags
® Red
Enable: 1099 Company Database (*.db) | <]
Cancel Open
2. Browse to the location where the database is saved.
3. Select the database and click Open.

The database is added to the list in the Database Manager.
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Rename Database

This option allows you to rename the database. It is recommended that you use only alpha-
numeric characters.

1. Click Rename Database. The

following alert appears:

Warning! Modifying database file may be unsafe! Continue anyway?

1f you are the only one who accesses this database, you may safely continue renaming or moving the &
databace now and ignore the following insructions.

Other users accessing this databace from different computers will need to re<ocate this databace after
renaming or moving. If the databace is being accessed by multiple users, please follow these
instructions to succussfully modfy this database file and re-Jocate it on other computers:

(1) Bxat CheckMark 1099 all other computers that access this database.

(2) Contirwe modifying the database file from this computer.

(3) For each computer that accesses this database, complete the following steps:
(4) Launch Cheddvark 1099 and open the Database Manager from the Fie' menu.
(smmmmmmmmmm

"Briggs
(6) Click 'OK' when informed that 1099 is unsble to locate the databasa,
(7) Click the Locate Database’ button.
(8) Navigate the Fie Dialog to find the modified databace fle.
(9) Click 'Open’ to finich re-locating the databace.

2. Click Yes. Otherwise, if you don’t want to rename at this time, click no
3. Enter the new name and click Rename Database to save.

The Rename Database window appears:

New Name
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Remove From List

This option allows you to remove a database from the list.

Note: This only removes the listing in the Database Manager. It does not delete the database file
from the saved location. To delete a database, you will need to manually delete the
database (.db) file from your hard drive or saved location.

1. Click Remove From List.

A Warning message appears

Database Manager

\  Remove database from list?
Are you sure you want to remove the selected database from the list? -

-
-
2. Click Yes to remove the database from the Database Manager list.

You can add the database again at anytime by using the Add Database command
as long as you don’t delete the database from the computer.

Open Database

This option allows you to choose a different database and open it up to view all
saved companies in that particular database.

1. Select the database you want to open and click Open Database.

The new database is now open and all companies stored in this database are
now available.

Close Database Manager

This option closes the Database Manager window.
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Update Company

This commands allows you to update the currently selected company’s information. Once
the program is launched, open the database that contains the company you want to update.
Highlight the company and click the Update Company command. Enter the information
you want to change, then click Update Company to save the changes.

New Company

This Command allows you to add a new company to the database that is currently open.
Once the program is launched open the database you wish save the company in. Click New
Company then enter the information for this company. Click Add Company to save the
company to the database.

Delete Company

This command allows you to delete a company from a currently opened database. Once
the program is launched open the database that contains the company you want to remove.
Click Delete Company and a screen will appear to make sure you want to delete the
company. Click Confirm Delete to complete the deletion process.

Exiting CheckMark 1099

To exit or quit CheckMark 1099:
. Choose Exit from the File menu (Windows)

. Choose Quit from the CheckMark 1099 menu (Mac)
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Chapter 3
Creating a New Company

This chapter shows you how to create a new company file and enter basic company
information.

Creating a New Company

1.

On Windows, double click the 1099 shortcut on the desktop or click the Start menu,
select Programs, then select CheckMark 1099 from the CheckMark Inc. File.

On Macintosh, double click on the CheckMark 1099 alias on the dock or on your
Desktop, or double click the CheckMark 1099 icon located in the install folder
that was installed on your hard drive

2. Click the New Company button in the middle of the screen.
00 CheckMark 1099 Print 2017

‘a CheckMark”
N 1099 Software

Companies Filter

Sample Co
Update Company New Company Delete Company
Recipients 0 of 0 Filter All Forms o Al Status [T

Update Recipient New Recipient Delete Recipients Copy Recipient

Database: CheckMark 1099 Database - 1099 Year 2017

Path:

/Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db
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Note: If the New Company button is greyed out that means you need to first open
a database or create a database. For Creating a Database please see page 9

3. Enter Payer Information for all pertaining fields.

T —— e

CheckMark’
1099 Software

Company Information
Payer’s Namne Payer's Address Contact Person
Payer’s Federal 1D Payer's Gty Contact's Phone
Payer's State Contact’s Email Address
Payer’s ZIP Contact’s Fax Number
Payer’s Phone Tax ID is Social Security Number
This &s your FINAL RETURN

‘__Mdcomp.ny | Update Company. | Cancel

4. Click Add Company button to Save.

Updating an Existing Company

1. Highlight the company in the list you wish to update and click the Update
Company button.

2. After all changes have been made to the Payer Information, click the Update Com-
pany button to save the changes
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Deleting a Company

You cannot delete a company if there are any recipients created within the company.
You must delete the recipients first before deleting a company. For information on
deleting recipients see “Deleting a Recipient” on page 32.

1. Select the company you wish to delete.
2. Click Delete Company

3. In the pop-up window, click the Confirm Delete button.

CheckMark”
1099 Software

Please verify that you want to delete the following company
Hauptman Security

[ Confirm Delete ] Cancel

If no recipients are associated with this company, the company will be deleted.

Filtering Companies

You can use the Filter button to search for certain companies in the list. To find a
particular company, enter all or part of the name of the company into the Filter box area at
the top of the screen and click the Filter button. The Filter will search for any companies
that contain those variables.

You can also use an asterisk (*) to help sort groups. For instance, if you enter the first letter and
then asterisk, (ex: N*), you will receive all companies that begin with the letter “N”.
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Sorting Companies

You can sort companies by Ascending or Descending order. To select which type of sort
to use, go under the Sort menu at the top of the screen and choose either Sort Companies
Ascending or Sort Companies Descending.

File Tools FontSizes [EEI{#] Window Help Vv 3 <O L]« @ Mon9:18 PM

000 v Sort Companies Ascending
Sort Companies Descending

v Sort Recipients Ascending
Sort Recipients Descending
Companies Filter
Sample Co
Update Company New Company Delete Company
Recipients 0 of 0 Filter All Forms |5 Austatus B
Update Recipient New Recipient Delete Recipients Copy Recipient

Database: CheckMark 1099 Database - 1099 Year 2017
Path: /Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db
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Selecting Multiple Companies

You can Select multiple companies if you choose to eFile 1099s using the IRS FIRE system.

Consecutive Selection

Windows: You can select multiple companies by selecting the first company you want
while holding down the mouse button and moving the mouse pointer down through the list.

You can also click on the first company, hold down the ‘Shift’ key on the keyboard, and

then click on the last company you want in the list.

Macintosh: Click on the first company you want in the list, hold down the ‘Shift’ key on

the keyboard, and then click on the last company you want in the list.

[CHECHC] CheckMark 1099 Print 2017

CheckMark”
1099 Software

Companies Filter

ABC Company

Update Company New Company Delete Company
Recipients 0 0f 0 Filter AllForms  [&] | Al Status B
Update Recipient New Recipient Delete Recipients Copy Recipient

Database: CheckMark 1099 Database - 1099 Year 2017
Path: /Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db
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Non-Consecutive Selection

Windows: To select specific companies as a group, click on the first company you want,
hold down the ‘Ctrl’ key on the keyboard and click on any other companies you want to

include.

Macintosh: To select specific companies as a group, click on the first company you want,
hold down the ‘Command’ key (also referred to as the Apple key) on the keyboard and

click on any other companies you want to include.

000 CheckMark 1099 Print 2017

CheckMark”
1099 Software

Companies Filter

ABC Company
Sample Co

XYZ Co

Update Company New Company Delete Company

Recipients 0 of 0 Filter All Forms [ Austatus <]

Update Recipient New Recipient Delete Recipients Copy Recipient

Database: CheckMark 1099 Database - 1099 Year 2017
Path: /Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db
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Chapter 4
Set Up

Setting up Users and Passwords

IMPORTANT: Although not required, it is recommended you set up a password to
protect your private information

1. Click on the Tools menu in the upper left hand corner of the screen and select Admin
m Font Sizes Sort Window Help D % <O LI« @ Mon9:23PM
(X Admin 8 CheckMark 1099 Print 2017
Backup Database "
Restore Database CheckMark
Edit Printing Formats 1099 SOﬁ:WG re
Cot Edit Page Setup Filter

Update Company New Company Delete Company

Recipients 0 of 0 Filter AllForms  [&] | Al Status B

Update Recipient New Recipient Delete Recipients Copy Recipient

Database: CheckMark 1099 Database - 1099 Year 2017
Path: /Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db
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2. To create a new user click the Add User button.

¥ CheckMark”
</

1099 Software

Users

Mercedes

Update User Delete User

3. Enter the Name and Password.

Note: The Name and Password are case sensitive.

4. Click the checkbox for This user should be granted ADMIN privileges if you
want this user to be able to add, update or delete other users.

IMPORTANT: The first user set up will have Admin privileges. You cannot delete or
change this user’s ADMIN privileges until another user with Admin privileges is created.

Users with ADMIN privileges can add/delete/update other users, Backup and Restore the
database and Check for updates.
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@ CheckMark
1099 Software
User Information
User Name San Il
Password eeeveee
Re-enter Password eevenes
This user should be granted ADMIN privieges
r_-:Md__l:l;!i_} Update User | Cancel
5. Click the Add User button to save.

Updating Users

Howon

Click on the Tools menu in the upper left hand corner of the screen and select Admin.
Highlight the user you want to update from the list.
Click the Update User button.

Make the necessary changes and click the Update User button to save.

Deleting Users

1.

2.

Click on the Tools menu in the upper left hand corner of the screen and select Admin.
Highlight the user you want to delete from the list.
Click the Delete User button.

In the popup window, verify that the correct user name is selected and click the
Confirm Delete button.
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CheckMark”
1099 Software

Please verify that you want to delete the following user

Note: If you delete all users, the software will not prompt for a password upon launching
the program.
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Setting Screen Font Size

This setting allows you to customize how big or small you want the font on the screen in
the program. There are five settings to choose from: Smallest Font, Small Font, Medium
Font, Large Font, Largest Font.

Selecting Font Size
1. Click on the Font Sizes menu at the top of the screen.

2. Select which font you want to use. You can choose any font at anytime from
the main screen window

File Tools Sort Window Help U R <P L 0 @) Mon9:24 PM Kristi Fish(
000 | SmallestFont | CheckMark 1099 Print 2017
Small Font
v Medium Font ™
Large Font CheckMark
Largest Font 1099 Software
Companies Filter

ABC Company

Sample Co

XYZ Co

Update Company New Company Delete Company

Recipients 0 of 0 Filter All Forms a All Status

[ <> |

Update Recipient New Recipient Delete Recipients Copy Recipient

Database: CheckMark 1099 Database - 1099 Year 2017
Path: /Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db

VA
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Adjusting Screen Size
You can adjust the size of each screen to maximize or minimize your viewing area.

To increase or decrease the size of any screen, simply click and hold the mouse button on
the lower right hand corner of any screen and drag the corner to the desired position.

CheckMark”
1099 Software

Company Information

|E
Payer's Name Payer's Address Contact Per:
m 123 canal D Mercedes |

Payer's Federal ID Payer's City Contact's Pl'f _
11-1234567 Kennewick 123-234-¢

Payer's State  Contact's Er
WA Mercy@me)

Do sy’ i Canbnndin Ba ™~
i ] ’

Add Company [ Update Company ] [ Cancel ]
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Chapter 5
Setting Up Recipients

This chapter explains how to setup new Recipients for each company.

Creating New Recipient

1. Open the Database that contains the company to which you want to add recipients. If no
Database exists you must first create one. See “Create New Database” on page 9.
2. Select a Company from the list. If no Companies are listed, you must first set up a
company before adding recipients. For information on setting up a new company,
see “Creating a New Company” on page 15.
3. Click the New Recipient button.
CheckMark’
| (NTJ 1099 Software
Companies Filter
ABC Company
)S(aY';'EI: Co (] CheckMark 1099 Recipient Type :
‘i CheckMark”
U ") 1099 Software y
Please select the type of 1099 Recipient to create
Recipients 0 of 0 Fill ©MISC DIV (INT (R S ¢ All Status 5

‘ OK Cancel

Update Recipient New Recipient Delete Recipients Copy Recipient

Database: CheckMark 1099 Database - 1099 Year 2017

Path:

/Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db

The list of fields for the new recipient corresponds to the same fields found on the 1099 forms

4.

Choose which type of 1099 form this recipient should receive and click OK.
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o0 vt -
CheckMark
1099 Software
1 VOID 71 CORRECTED
Payer lefo 1 Reots OMB No. 1545-0115
$
Marrock
123 Keeoe Rd .t
Kennewick, WA 1245 111-204-124 : Royaties Form 1099-MISC
3 Other income 4 Federd income tax withheld
s s
Payer Federd 10 Redplents 1D 5 Fishing boat peoceeds 6 Medical and health care payments
334234567 $ $
Recipient Information Address not in US Territory 1 ;muomwnm :mw‘mmdo«m«mu
Comparry o¢ Last Name First Name (f applicable) 9 Payer made diect safes of $5,000 T 10 Crop iesurance proceeds
or mace o consumer products 10 3 $
Address buyer(recigient) for resale
oty Qate piid Country G £
Account Number (see mstructions)  FATCA filing requirement 2nd TIN not. 13 Excoss golden parachute payments 14 Gross proceeds paid 1o an attormey
n 3 s s
Previous Recioient | | Add Recipient | - Update Recipient | Cancel | | Next Recpient
5. Enter the Recipient’s ID along with the Recipient’s Information.

6. Fill in any fields that are applicable for the recipient.
7. Click the Add Recipient button to Save the information.

If any information is invalid, a popup window will open explaining which fields have errors.

CheckMark”
1099 Software

‘ The following errors were discovered:

'Address: Must be between 1 and 40 characters.

City: Must be between 1 and 40 characters.

‘State: Must be a valid U.S. state or territory (name or abbreviation).
'ZIP: Must be of form 000X or XX000(-X000K.

Continue Anyway | [Canoel]
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Press cancel to go back to the set up screen to correct any errors, or Continue Anyway to
Save the recipient information

NOTE: If any field has an invalid entry, once you return to the Recipient set up screen,
that field name will show up in “Red”. In addition, some fields will not save the invalid
information and remain empty. For more information on validated information, see
“Validated Status” on page 37.

Updating an Existing Recipient
1. Select the company that contains the recipient(s) you wish to update.

2. Highlight the recipient in the list you wish to update and click Update Recipient
but-ton.

3. After all changes have been made to the Recipient Information, click
Update Recipient button to save changes.

v .l!

CheckMark™
1099 Software

VOID I CORRECTED

P Info

1 Rente OME No. 15450115
- $1.00
Mercy's Garage 1.6 2015
123 Cand Dy
Kennewic, WA 12345 123 234-4%0 ; Royelties Form 1099-MISC
2.00
3 O Income A Fadersl incoma b wihhald
$3.00 $3.00
Paryer Fodes 1D 6 Medical and heslth care payments
11124557

$ 6.00

Redgient Information

Address notln US T 7 Nonemployee comperaation 8 Subsiiste paymmants i flew of dhidends or interest

$7.00 58,00

Compeny or Last Neme First Mome (¥ apgplicable) o ke drect sales of $5.000 ¥ 10 Crop insurange precneds

COXrnick charles o consumer preducts (0 a $ 10,00

Address buyee(reciiont) for recle

123 Susmit View Dr

Oy Stive p Country

rennewick Wa

umbar (W Instructiond)  FATCA 1880 reguirement 204 TIN not coneds Pl 10 an aseIney
7 7

If any information is incorrect, a popup window will open explaining which fields have
errors.
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CheckMark’
1099 Software

The following errors were discovered:
Address: Must be between 1 and 40 characters.
City: Must be between 1 and 40 characters.
State: Must be a valid U.S. state or territory (name or abbreviation).

ZIP: Must be of form X000 or Y0000,

Continue Anyway

Press cancel to go back to the set up screen to correct any errors, or Continue Anyway to
Save the recipient information.

NOTE: If any field has an invalid entry, once you return to the Recipient set up screen,
that field name will show up in “Red”. In addition, some fields will not save the invalid

information and remain empty. For more information on validated information, see
“Validated Status” on page 37.

Voided Recipient

If a 1099 is incorrectly filed, or included in a filing, that was incorrectly filed, you can

resubmit the 1099 as a Voided copy to void the original 1099 to the IRS. Please read the
IRS Instructions on how to file this.

1. Select the recipient from the list and click Update Recipient button
2. Click the Void check box at the top of the screen.

If the recipient’s Status is already considered Printed and/or Completed, you’ll receive a pop
up window asking if you would like to change the status back to Not Printed and/or Not
Completed. For information on what the different Statuses mean, see “Status” on page 36.
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CheckMark”
1099 Software

The Recipient Information you are updating has already been 'Printed'".
Change status to 'NOT Printed"

Save and Continue ’ Cancel ’

3. Mark the corresponding checkbox next to “NOT Printed’ and/or “NOT Complete”
if you want to change the status and click the Save and Continue button. If you do
not want to change the status, click the Cancel button. If you do not select either
checkbox, you can still click the Save and Continue button to save any updated
recipient information without changing their status.

If you initially printed the form, reprint another 1099 with the updated Void status and
submit that form to the IRS with a new 1096 form. for instructions on printing 1099 forms,
see “Printing 1099s for Recipients” on page 57.

If you initially e-filed, create a new .txt file with that recipient and updated Void
information and submit it to the IRS. For information on e-Filing, see “Creating a file to
eFile” on page 64.

Corrected Recipient

If a 1099 is filed, or included in a filing, with incorrect information, a Corrected 1099
must be filed with the IRS.

1. Select the recipient from the list and click the Update Recipient button.

2. Click the Corrected check box at the top of the screen, update any information
and click the Update Recipient button to Save.

If the recipient’s Status is already considered Printed and/or Completed, you’ll receive

a pop up window asking if you would like to change the status back to Not Printed

and/or Not Completed. For information on what the different Statuses mean, see “Status”
on page 36.
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oo e I e
CheckMark”
</

1099 Software

The Recipient Information you are updating has already been 'Printed'.
Change status to ‘NOT Printed' -

Save and Continue [ Cancel J

3. Mark the corresponding checkbox next to “NOT Printed’ and/or “NOT Complete”
if you want to change the status and click the Save and Continue button. If you do
not want to change the status, click the Cancel button. If you do not select either
checkbox, you can still click the Save and Continue button to save any updated
recipient information without changing their status.

If you initially printed the form, reprint another 1099 with the updated Corrected status
and submit that form to the IRS with a new 1096. for instructions on printing 1099 forms,
see “Printing 1099s for Recipients” on page 57.

If you initially e-Filed, create a new .txt file with that recipient and updated Corrected
information and submit it to the IRS. For information on eFiling, see “Creating a file
to eFile” on page 64.

Deleting a Recipient

1. Select the company that contains the recipient(s) you wish to delete

2. Highlight the recipient in the list you wish to Delete.
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If you want to delete more than one recipient, you can highlight multiple recipients at once.
See “Selecting Multiple Recipients” on page 38.

3. Click Delete Recipient button.

4. A pop-up window appears to confirm that these are the recipients you want to delete.

CheckMark’
1099 Software

Please verify that you want to delete the following recipients:
Corrnick, Samuel

[CanoelJ

5. Click Confirm Delete to complete the process.

Copy Recipient

If you have a recipient that needs to be included in multiple companies or requires different
types of 1099 forms, you can easily copy that person’s set up information and add them
either under a new company and/or with a different type of 1099 form.

1. Select the company that contains the recipient(s) you wish to copy.
2. Highlight the recipient in the list you wish to copy.

3. Click the Copy Recipient button.
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4. A pop-up window appears. Select which company and which type of 1099 form
this recipient should be copied as.

Checkl\Mark”
1099 Software

Please select the Company and 1099 Type to copy Samuel Corrnick to.

Company Mercy's Garage - |

‘ eMISC ©DIV OINT ©R ©S

| OK || Cancel |

S. Click OK to copy the recipient.

Filtering Recipients

You can use the Filter button to search for certain recipients in the list. To find a
particular recipient, enter all or part of the name into the Filter box area above the
recipients section and click the Filter button. The Filter will search for any recipients that
contain those variables.

You can also use an asterisk(*) to help sort groups. For instance, if you enter the first letter and
then an asterisk, ex: N*, you will receive all recipients that start with the letter “N”".

IMPORTANT: When filtering, make sure you choose the appropriate form you want to
search in. If filtering from All Forms, recipients will be searched from the entire company.
If however, you choose DIV Forms for example and filter certain variables, only those
recipients set up as receiving a 1099-DIV will be displayed in the results.
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Sort Recipients

You can sort recipients by Ascending or Descending order. To select which type of sort
to use, go under the Sort menu at the top of the screen and choose either Sort Recipients
Ascending or Sort Recipients Descending.

File Tools FontSizes JEIJ] Window Help V) 3 <O L] ¢ @ Mon9:18 PM
[ X X ) | v Sort Companies Ascending 2017
Sort Companies Descending

v Sort Recipients Ascending
Sort Recipients Descending

Companies Filter

Sample Co

Update Company New Company Delete Company

Recipients 00f0 Filter All Forms |2 | AllStatus o

Update Recipient New Recipient Delete Recipients Copy Recipient

Database: CheckMark 1099 Database - 1099 Year 2017
Path: It isti 'Documents/Cl 1099/2017/Ct 1099 Database 2017.db




Chapter 5 Setting Up Recipients 36

Status

The Status drop down menu has certain statuses that are categorized based upon their setup and
completion of being printed. You can sort using the different options to see which employees or
vendors have been Printed, Completed, Validated, Voided, or Corrected.

Recipients can be in multiple statuses at the same time, however you can only sort by one
status at a time.

NOTE: Before choosing a Status, you should first select one or more companies in the list.
For information on selecting multiple companies see “Selecting Multiple Companies” on

page 19.
XX CheckMark 1099 Print 2017
CheckMark”
1099 Software
Companies Filter

ABC Company

Sample Co

XYZ Co

Update Company New Company Delete Company

Recipients 1 of 1 Filter MISC forms E v All Status
NOT Printed

Dylan, Robert Printed
NOT Completed
Completed
NOT Validated
Validated
NOT Voided

Update Recipient New Recipient Delete Recipients Copy R Voided
7 NOT Corrected
Database: CheckMark 1099 Database - 1099 Year 2017 Corrected

Path: /Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db
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Printed Status

Printed Status
You can easily sort using this status to see which recipients still need the form 1099 printed.

You can select either Printed or Not Printed status to sort for recipients by whether or not
you have printed a 1099 for them. Once you select the Print Forms for Recipient
command from the File menu, that recipient will automatically be moved to the Printed
status from the NOT Printed status.

Completed Status

You can use the Completed status to indicate which recipients have or have not been
printed or e-Filed this form 1099 for employer related copies.

Once you select the Print forms for Filing option under the File menu, recipients listed
under NOT Completed will be moved to the Completed status.

Validated Status

Sorting by Validated or NOT Validated helps you easily determine if there is any
recipient that is not set up correctly. In the recipient screen, certain fields require specific
characters, numbers, etc. to be accepted upon filing.

Select Validated to see which recipients are ready to be filed. Select NOT Validated to
see any recipients that have set up criteria which is incorrect for filing purposes. Once you
have sorted by NOT Validated, select a recipient and click on the Update Recipient
button to view the set up and make necessary changes. Fields marked in “RED” do not
meet the requirements for filing and corrections should be made.

Voided Status

In the Recipient set up screen, there is a checkbox at the top of the screen for Void. If
you filed a 1099 for a recipient that was unintended, you can mark Void to resent the
1099 for that recipient as a void status.

Choosing a Voided status will list all recipients marked Void in the Recipient set up screen.
All other recipients that are not marked Void in the recipient set up screen are listed as
NOT Voided for a status.

Corrected Status

In the Recipient set up screen, there is a checkbox at the top of the screen for Corrected. If
you filed an incorrect 1099 and need to resubmit a new 1099 with updated information,
select the Corrected checkbox in the recipients set up screen before submitting the new
1099 information.
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The Corrected status indicates all recipients who are marked as Corrected in the recipient
set up screen. All other recipients will be listed as Not Corrected.

Selecting Multiple Recipients

Consecutive Selection

Windows: You can select multiple recipients by clicking the first recipient while
holding down the mouse and moving the mouse down through the list

You can also click the first recipient, hold down the ‘SHIFT’ key on the keyboard and
then click on the last recipient you want in the list.

Macintosh: Click on the first recipient you want in the list, hold down the ‘SHIFT’ key on
the keyboard and then click on the last recipient you want in the list

[ X X ) CheckMark 1099 Print 2017
CheckMark”
1099 Software
Companies Filter
ABC Company
Sample Co
XYZ Co
Update Company New Company Delete Company
Recipients 3 of 3 Filter MISC forms B All Status B

Dylan, Robert

Jagger, Mick
Jett, Joan

Update Recipient New Recipient Delete Recipients Copy Recipient

Database: CheckMark 1099 Database - 1099 Year 2017
Path: /Users /kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db
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Non-Consecutive Selection

Windows: To select specific recipients as a group, click on the first recipient you want, hold
down the ‘CTRL’ key on the keyboard and click on any other recipients you want to include.

Macintosh: To select specific recipients as a group, click on the first recipient you want,
hold down the ‘COMMAND’ key on the keyboard (also known as the Apple key) and click
any other recipients you want to include.

000 CheckMark 1099 Print 2017
CheckMark”
1099 Software
Companies Filter
ABC Company
Sample Co
XYZ Co
Update Company New Company Delete Company
Recipients 3 of 3 Filter MISC forms |5} = All Status B

Dylan, Robert

Jagger, Mick

Update Recipient New Recipient Delete Recipients Copy Recipient

Database: CheckMark 1099 Database - 1099 Year 2017
Path: /Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db
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Chapter 6
Exporting and Importing

This chapter explains how to export employees and companies from CheckMark Payroll as
well as vendors from CheckMark MultiLedger and how to import this information from
CheckMark Payroll, MultiLedger or tab-delimited text file.

Exporting Recipients from CheckMark Payroll
1. Open up CheckMark Payroll, go under File menu and choose Export Employees

2. Highlight which recipients you want to export from the list.

Note: If the recipients to be imported are using different types of 1099 forms, you should
create multiple export files for each type of form. Example, one export file for 1099 MISC,
one file for 1099 INT, etc.

3. Click the Export 1099 button. The Selected Field list will automatically populate
with the correct available fields to import into the 1099 software.

4. A Save dialogue box appears in the File name field, give the file a name if needed
and choose a location to save the file to, an example would be your Desktop.

5. Click Save.
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Exporting Companys From CheckMark Payroll

1. Open CheckMark Payroll, then open the Company you wish to export.
2. Under the File menu select Export Company to 1099.
3. A Save dialogue box appears. In the File name field, give the file a name if needed and

choose a location to save the file to, an example would be your Desktop.

.

1y

LGN | = Occsmets » My Docmens » Crctok > Poyot » 6 » Fepots = 4y | s s

-,;.sm-tes 5 [?oc::men(s library Mg Fokder ™
Desitop Keports

& Downloads Name = Date modéied Type Sce

. Recent Places
. Misc Emgloyees 9227201582) AM Tet Decument
o Lbeanes =

L‘ uﬁt\‘ ents |

-5 Music

e Pictures

B videos

= Computer
& Lecal Dk (C)
Lot e shaces (\\na

S Network
= pACKe
1 OESHOLIWAD
- OeS-MAC

Fie name
Save o type {l’dﬂcrm

= Hide Folders

4. Click Save.
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Exporting Recipients from MultiLedger

1.

2.

Open the MultiLedger program, under the File menu select Export...

@& MultiLedger Edit Setup Transactions Reports Window Help 9
[ New Company 8N
Open Company... ®0

Open Recent Company >
Close Company

Company
Information

Account Trial
Reports Balance

Backup Company
Restore Backup...
Interface Rebuild Files... Transaction General
Accounts . Journals Ledger
Rename Files...
- - Find Company...
Financial Renumber Accounts...

Statements

Close Year...

Customer
Setup

Balance Income
Sheet Statement
Cash Flow Financial
Format... Snapshot
Page Setup...
Select Print Font... ; Customer Vendor
. o Reports Reports
Import...

ltem
Setup

Sales Tax Preferenc.es... Item Job
Setup User Settings... Reports Reports
Export Company...

Customer
Terms

il fefi

Sales Tax Salesperson
Report Report

Select Vendors from the drop-down menu at the top.

> Transactions Reports Window |~ A Y R U )« @) Mon
LN Quotes
Customers {
1st Bank || Separate City/State/Zip
AIC Advertising
BTS Distribution Supply Items Export To 1099
Bank Accounts o o TS
ue Cross
Blue Cross-CP Jobs
CA Dept of Labor Export TXT Export CSV
CA Dept of Revenue SalesDeoDle
CO Dept of Labor Copy Remove

CO Dept of Revenue
CheckMark Sof tware . .
City Dept of Rev Field List Export List

City of Denver Name Name

Credit Card Company Code Code

EDD Contact Contact
EDD-ETT Address Address
EDD-SOD1 City/State/Zip City/State/Zip
El Paso Steak House Notes /Ref# Notes /Ref#
F!nanc!al Group Add'l Notes Add'l Notes
Financial Group - S Phone Phone

IRS . Tax 1D Tax I1D
Labor Union Fax Fax

Hugrt\oliu Rental Properties Default Acct Default Acct
Office Mart Default Amt Default Amt
Po;tmt_:ster . X Due Days Due Days
Principal Financial Credit Limit Credit Limit
Sample Co Emai L

State Dept of Rev Web

Terry's Supply Store
Town Recorder
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3. Make sure you select the correct period and click the Export to 1099 button.

[ X N} Export
1st Bank Separate City/State/Zi
AIC Advertising Vendors | v ] s vl e
BTS Distribution Supply
Bank August 16 [T Export To 1098
Blue Cross |
Blue Cross-CP
CA Dept of Labor Copy All Export TXT Export CSV [

CA Dept of Revenue
CO Dept of Labor

CO Dept of Revenue
CheckMark Software

City Dept of Rew Field List Export List
City of Denver Name Name
Credit Card Company Code Code
EDD Contact Contact
EDD-ETT Address Address
EDD-SDI City/State/Zip City/State/Zip
E.l Pas9 Steak House Notes/Ref# Notes/Ref#
F!nunc!al Group Add'l Notes Add'l Notes
Financial Group - 5 Phone Phone
IRS Tax 1D Tax 1D
Labor Union Fax Fax
ﬂaglflolia Rental Properties Default Acct Default Acct
Office Mart Default Amt Default Amt
Po;tmgster ) . Due Days Due Days
Principal Financial Credit Limit Credit Limit
Sample Co Emai L
State Dept of Rev Web
Terry's Supply Store
Town Recorder

4, A Save dialogue box appears. In the File name field, give the file a name if needed and

choose a location to save the file to, an example would be your desktop.

5. Click Save.

Importing Recipients from CheckMark Payroll and Multiledger.
1. Open the CheckMark 1099 application.

2. Open the Database which contains the company you want to import into.

Note: If the company you want to import recipients to does not exist, you will need to
create a new company or import a company before importing recipients. For information
on creating a new company or importing a company, see “Creating a New Company” on
page 15 or “Importing a Company” on page 47.
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3. Under the File menu select Import...

int G Tools FontSizes Sort Window Help O % <O & @) Mong:40PM Kristil
Create Database L CheckMark 1099 Print 2017

CheckMark”
1099 Software

Filter

Import Prior Year
Open Database
Database Manager
Close Database

EFile...

Summary Report
Mailing Labels

Print Forms for Recipient
Print Forms for Filing

E
rupuate Company New Company Delete Company

Open Database

Recipients 3 of 3 Filter \ MISC forms All Status

Dylan, Robert

Jagger, Mick

Update Recipient New Recipient Delete Recipients Copy Recipient

Database: CheckMark 1099 Database - 1099 Year 2017
Path: /Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db

4. Select Recipient in the popup window.

CheckMark”
1099 Software

Please select the type of 1099 import you are importing
© Company @ Recipient

| OK || cancel |
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5. In the popup window select which type of 1099 recipient(s) you are importing: MISC,
DIV, INT, R or S and which company you want to import the recipients to.

CheckMark”
1099 Software
Please select the type of 1099 Recipients you are importing

Select Companies

Hauptman Secur
Marrock

Mercy's Garage

eMISC ©“DIV OINT ©R 0S

Cancel

OK

6. Click OK
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7. Click the Import from Payroll or MultiLedger button. The appropriate fields will
automatically populate for you.

| CheckMark”
1 1099 Software

ﬂ | Import from Payroll o MukiLedger |

b .
Company/Last Name (Required) 2 Company/Last Name (Required)
First Name First Name
Address Line 1 Address Line 1
Address Line 2 City
City State
State . 2 1P Code
2P Code Add Bed 2 Recipient’s 1D
Country Add Al Fields >
Address not in U.S, - Checkbox
Account Number <= Remave Field
FATCA - Checkbox
20d TIN net. - Checkbox <7z, Remove Al Fickds
Void - Checkbox
Corrected - Checkbox
Box 1: Rents
Box 2: Royaities

Box 4: Federal income tax withheld

mpoe | | Cancel

8. A Look in screen for Windows or choose the file to Import screen for Macintosh
appears allowing you to browse to the location where you saved your text file
from CheckMark Payroll or MultiLedger.

9. Select the text file and click Open. All recipients will be imported into the
selected company.
Importing a Company from CheckMark Payroll
I. Open the CheckMark 1099 application.

2. Open the Database you want to imprt the company into.

Note: If the database that you want to import recipients to does not exist, you will need
to create a new database before importing. For information on creating a new database
see “Creating a New Database” on page 9.

3. Under the File menu select Import...
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m Tools FontSizes Sort Window Help O 3 <O L« @) Mon9:40PM Kristif
Create Database | CheckMark 1099 Print 2017

CheckMark”
1099 Software

Import Prior Year
Open Database
Database Manager
Close Database

Filter
EFile...
Summary Report
Mailing Labels
Print Forms for Recipient
Print Forms for Filing [
r~upuate Company New Company Delete Company
Open Database
Recipients 3 of 3 Filter MISC forms All Status B

Dylan, Robert

Jagger, Mick
Jett, Joan

Update Recipient New Recipient Delete Recipients Copy Recipient

Database: CheckMark 1099 Database - 1099 Year 2017
Path: /Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db

4. Select Company in the popup window.

CheckMark”
1099 Software

Please select the type of 1099 import you are importing

< Company @ Recipient

| OK || cancel |

5. Click OK

6. Click the Import from Payroll or MultiLedger button. The appropriate fields will
automatically populate for you.
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CheckMark”
1099 Software

[ Import from Payroll or MultiLedger ]
Available Fields Selected Fields
Payer's Name Payer's Name
Payer's Federal 1D Payer's Federal 1D
Address [ Add Field --> ] Address
City - City
State  Add All Fields --> = State
Z1P 2P

Phone | <-- Remove Field | Phone
<~- Remove All Fields

Import : Cancel

7. A Look in screen for Windows or choose the file to Import screen for Macintosh
appears allowing you to browse to the location where you saved your text file from
CheckMark Payroll.

8. Select the text file and click Open. All recipients will be imported into the selected
company.

Importing using a tab-delimited text file.
1. Open up the CheckMark 1099 application.

2. Open the Database which contains the company you want to import into.

Note: If the company you want to import recipients to does not exist, you will need to
create a new company or import a company before importing recipients. For information
on creating a new company or importing a company, see “Creating a New Company” on
page 15 or “Importing a Company” on page 47.

3. Go under the File menu and select Import...
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int IGT Tools FontSizes Sort Window Help D % <O & @} Mon9:40PM Kristil
Create Database | CheckMark 1099 Print 2017

CheckMark”
1099 Software

Filter

Import Prior Year
Open Database
Database Manager
Close Database

EFile...

Summary Report

Mailing Labels

Print Forms for Recipient
Print Forms for Filing

up Company New Company Delete Company

Open Database

Recipients 3 of 3 Filter || MISC forms  |&] | All Status B

Dylan, Robert

Jagger, Mick
Jett, Joan

Update Recipient New Recipient Delete Recipients Copy Recipient

Database: CheckMark 1099 Database - 1099 Year 2017
Path: /Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db

4. Select Recipient or Company in the popup window.

CheckMark”
1099 Software

Please select the type of 1099 import you are importing

< Company @ Recipient

| oK || cancel |

5. In the popup window select which type of 1099 recipient(s) you are importing: MISC,
DIV, INT, R or S and which company you want to import the recipients to.




51

CheckMark®
1099 Software

Please select the type of 1099 Recipients you are importing
Select Companies

Hauptman Secur
Marrock
Mercy's Garage

@MISC ©DIV CINT ©R DS

. OK || Cancel |

6. The import screen allows you to select which fields are being imported. Select the
fields in the same order as the text file you’re importing. Click the Import button
after you have added all fields to the Selected Field list.

mvor g o
CheckMark’
1099 Software
| Import from Payroll or MuhiLedger |
Avalable Felds Selected Felds
CompanyLast Name (Required) - Company/Last Name (Required)
First Name First Name
Address Line 1 Address Line 1
Address Line 2 City
e e
ZIP Code temebdd e 2 Recipient’s ID
Country . Add Al Fields ->
Address not in U.S, - Checkbox
[Recipentsp |
N <= Remave Fieid
Fi « Checkbox [
;HT?INM - Checkbax S, Remove Al Fickls
Void - Checkbox
Corrected - Checkbox
Box 1: Rents
Box 2: Royalties
Bex 3: Other income
Box 4: Federal income tax withheld

7.

A Look in screen for Windows or choose the file to Import screen for

Macintosh screen appears allowing you to browse to the location where you

saved your text file.
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8. Select the text file and click Open. All recipients will be imported into the
selected company.

Text File Format for Importing

CheckMark 1099 program uses a tab-delimited .txt file for importing Companies and
the Recipients.

Each field is separated by a Tab with Return at the end of the record before starting the
next recipient. An example of a text file to be imported is shown below and contains the
Selected Fields: Company Name/Last Name (required), First Name, Address 1, Address 2,
City, State, Zip, Recipients ID.

Power[tab]Max[tab]44 Main St[tab]Ste 101[tab]Fort Collins[tab]CO[tab]80525[tab]123-
45-6789[return]

. If any fields are not applicable, for instance the address 2 field, a space can be used
as a place holder. For example:

Power[tab]Max[tab]44 Main ST[tab]”’space”’[tab]Fort Collins[tab]CO[tab]80525[tab]123-
45-6789[return]

. If no space is included, two consecutive [tabs] will also work. For example:

Power[tab]Max[tab]44 Main St[tab][tab]FortCollins[tab]CO[tab]80525[tab]123-45-
6789[return]

IMPORTANT: Make sure the items in the Selected Fields list are in the same order as
the items in the text file being imported to ensure that all values are imported into the
correct fields.
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Summary Report

Chapter 7
Printing 1099 Forms

This chapter explains how to print 1099 forms for the company and each recipient.

While CheckMark Inc. attempts to maintain up-to-date and accurate tax and form
information, we cannot be responsible for changes or discrepancies in tax values and
forms that are filed incorrectly.

IMPORTANT: You must install the latest version of Adobe Reader to print 1099 and
1096 forms properly. Go to www.adobe.com to download the latest update.

Summary Report

The 1099 Summary Report summarizes recipient payments by 1099 type. These totals can
be compared to Box 5 on Form 1096. Use this report to verify the accuracy of your
information before printing.

1. Go under File, select Summary Report. Click Print.
m Tools FontSizes Sort Window Help D % <O L0 & @ Mon9:45PM Kristif
.J Create Database L CheckMark 1099 Print 2017

Import...

Import Prior Year ™

il heckMark

Database Manager 099 Software
( Close Database Filter

EFile...

Summary Report

Mailing Labels

Print Forms for Recipient
Print Forms for Filing

p ( Company New Company Delete Company

Recipients 3 of 3 Filter MISC forms  [5] | All Status B

Dylan, Robert

Jagger, Mick

Update Recipient New Recipient Delete Recipients Copy Recipient

Database: CheckMark 1099 Database - 1099 Year 2017
Path: /Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db




Chapter 7 Printing 1099 Forms 54

Print 1099 Forms and 1096 Form for Each Company

1.
2.

Select the company you wish to print 1099s and a 1096 form.

Select which type of 1099 form you want to print from the Forms drop down menu:
MISC, DIV, INT, R, S.

Select which recipient(s) in the list you would like to print forms for. If no recipients
are selected, all recipients will be included.

Note: You can sort the recipients by using the Status drop down menu to group recipients
by Printed, Completed, Validated, Corrected, and Void. For more information on using
the Status drop down menu and what each Status means, see “Status” on page 36.

4. Under the File menu, select the Print Forms for Filing option.
m Tools FontSizes Sort Window Help VR VLt W =) Mon9:46 PM  Kristi |
® | Create Database L CheckMark 1099 Print 2017
Import... S
Import Prior Year ™
‘ CheckMark
Database Manager [N 1099 Software
( Close Database Filter
EFile...
Summary Report
Mailing Labels
Print Forms for Recipient
Print Forms for Filing
— upuate Company New Company Delete Company
Recipients 3 of 3 Filter MISC forms [ | All Status B
Dylan, Robert
Jagger, Mick
Jett, Joan
Update Recipient New Recipient Delete Recipients Copy Recipient
Database: CheckMark 1099 Database - 1099 Year 2017
Path: /Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db
4
5. A popup window appears.

The first section pertains to 1096 information. The default choice is to Use all recipients

for

1096 totals for the selected company. If you are filing Corrected or Voided 1099s, then

choose the Use selected recipients for 1096 totals option.
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The second section of the screen pertains to 1099s. The default choice is to Print 1099s for
all recipients. If you are filing Corrected or Voided 1099s and only want selected
recipients to be included, choose the Print 1099s for selected recipients options.

CheckMark™
1099 Software

Choose 'Use Selected’ if you are printing ONLY CORRECTED
and VOIDED 1099s, otherwise choose 'Use All' to use all
Mercy's Garage MISC recipients

©' Use ol recpients for 1056 totals Use selected recipsents for 1096 totals

Choose 'Print All Recipients' if you want to print 1099s for
all Mercy's Garage MISC recipients, otherwise choose 'Print
Selected Recipients'

© Print 10555 for ol recpients Print 10555 for selected recipients

**If printing 1099 MISC or INT Only**

If you are printing 1099 MISC or INT forms, you’ll be prompted to choose I Sent 2-up
forms to recipients or I sent 4-up forms to recipients. Choose the I sent 2-up forms to
recipients option if you plan on using 2-up pre-printed forms for all copies of 1099-MISC.
If you plan on printing Copy B, Copy 2 and Copy C for the recipient on blank paper, you
can select I sent 4-up forms to recipients. After making your selection, click OK.
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CheckMark’
1099 Software
Choose 'Use Selected' if you are printing ONLY CORRECTED

and VOIDED 1099s, otherwise choose 'Use All' to use all
Mercy's Garage MISC recipients

9 Use all recipients for 1096 totals ) Use selected recpients for 1096 totals

Choose 'Print All Recipients' if you want to print 1099s for

all Mercy's Garage MISC recipients, otherwise choose 'Print
Selected Recipients'

© Print 1099s for all recipients ' Print 1099s for selectad recpients

| contrwe | | cancel

NOTE: If you have not selected any recipients for the company selected, all recipients
will be printed.

A message box will open telling which form to load in the printer and how many.

Click OK after you have loaded the correct forms in your printer. Do this for each
message box that appears.

Please put 1 copies of 1099-MISC CopyA into the printer,
then hit ok
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Printing 1099s for Recipients

1. Select the company you wish to print 1099 forms for.
2. Select which type of 1099 form you wish to print from the Forms drop down menu:
MISC, DIV, INT, R, or S.

NOTE: Recipients shown will be for the type of 1099 form that is selected. You can
choose SHOW ALL to show all recipients, but you must select a specific 1099 form from
the drop down list to be able to print.

3. Select which recipient(s) in the list you wish to print 1099s for.

NOTE: You can sort the recipients by Status drop down menu to group recipients as
Printed, Completed, Validated, Corrected and Void. For more information on using
the Status drop down menu and what each Status means, see “Status” on page 35.

4. Under the File menu, select the Print Forms for Recipient option.
int Tools FontSizes Sort Window Help O 3 <O [« @) Mon9:47PM Kristil
® | Create Database ! CheckMark 1099 Print 2017

Import...

Import Prior Year i
Open Database CheCkMark
Database Manager 1099 Software
Close Database Filter
EFile...

Summary Report

Mailing Labels

l Print Forms for Recipient

| Print Forms for Filing L
rupuate Company New Company Delete Company

Recipients 3 of 3 Filter MISC forms  [o) | All Status ]

Dylan, Robert

Jagger, Mick

Update Recipient New Recipient Delete Recipients Copy Recipient

Database: CheckMark 1099 Database - 1099 Year 2017
Path: /Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db
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**If Printing 1099-MISC and 1099-INT only**

If you are printing 1099 MISC forms or 1099 INT forms, you’ll be prompted to choose
Print 2-up MISC or INT forms or Print 4-up MISC or INT forms. Choose Print 2-up
MISC forms option if you plan on using 2-up pre-printed forms for all copies of 1099
MISC. If you plan on printing Copy B, Copy 2, and Copy C for the recipient on blank
paper, you can select Print 4-up MISC Forms. After making your selection, click OK.

e T =

CheckMark’
1099 Software

Please select which 1099 forms you are using to print
recipients.

# Print 2-up MISC forms © Print 4-up MISC forms

If you choose "2-up’ we will separately create Copy B and
Copy 2 for each recipient. (Needs to be printed on
preprinted forms)

If you choose '4-up’ we will create a one page PDF
containing a Copy 2, Copy B, Copy 1 and Copy C's for each
recipient. (Needs to be printed on blank paper)

NOTE: Using the 4-up sheet method will produce two Copy Cs instead of one Copy 1

5. If printing 2-up on pre-printed forms, a message box will open telling you which form to
load in the printer and how many. Click OK after you have loaded the correct forms in
your printer. Do this for each message box that appears for each form.

Please put 1 copy of 1099-INT CopyB into the printer, then
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Edit Printing Formats

You can adjust each individual print field if printing on pre-printed forms.

1. Choose Edit Printing Formats located under the Tools menu.
int  File FontSizes Sort Window Help D % < W @ Mon9:49PM Kristif

®®® Admin L CheckMark 1099 Print 2017
Backup Database »
Restore Database CheckMark
Edit Printing Formats 1099 Softwa re

Comp: Edit Page Setup Filter
ABC Company
Sample Co
XYZ Co
Update C New Cq Delete C
0] )ase
Recipients 3 of 3 Filter MISC forms All Status B

Dylan, Robert

Jagger, Mick
Jett, Joan

Update Recipient New Recipient Delete Recipients Copy Recipient

Database: CheckMark 1099 Database - 1099 Year 2017
Path: [Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db

2. Select which forms you want to modify from the drop down menu: MISC 2-up form,
DIV form, INT form, R form, S form, 1096 form.

CheckMark”
1099 Software

1096 form
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3. Click Edit Current Custom Format. A window showing all print fields on the
selected form opens.

1 2 3 A 8 B z B
B E
[T T S [ T E—
e —— —

Poyerid ] tecipientid |} boxh | | T T
tecipicotoams. ]
box / 1 hox® ]
tecipientaddress |
E box 0
kecipicnt cite state 2ip-country
bhox 11 | box 12 ]
g
teclpient acct | " hexid 1 hexia ]
box 161 | boxiZ1 ] boxi81 |
boxi8a ] T L — box 162 1 hoxiF7 ) hexiB2 1

You can adjust any field by dragging it with the mouse. Or click on any field to highlight
and use arrow keys on the keyboards.

Double-clicking any field will turn the text from ‘black’ or ‘red’ or vice versa. Any field
labeled in ‘red’, will not print.

4, To reset the back to the default format, click the Reset Format button
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Edit Page Format (Mac Only)

If using a Macintosh computer, you must set the printing preferences the first time you
print to correctly format the page.

A warning message will appear the first time you try to print.

You can access the Edit Page Setup screen by clicking the Edit Page Setup button.
You can also access the Edit Page Setup screen under the Tools menu.

1. Click Edit Page Setup under the Tools menu.

2. Follow the instructions in the warning message. You can also print out the
instruc-tions to follow along.
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Chapter 8
eFile

This chapter shows you how to eFile 1099 forms using the IRS Filing Information Returns
Electronically (FIRE) System. If you have never eFiled 1099s in the past, You will need to
visit the IRS website at www.irs.gov to sign up for a FIRE system account and receive a

Transmitter Control Code (TCC), You should do this 45-60 days before the filing deadline.

While CheckMark Inc. attempts to maintain up-to-date and accurate tax and for
information, we cannot be held responsible for changes or discrepancies in tax values
and forms that are filed incorrectly.

NOTE: The ability to eFile is only is only available to customers who have purchased
the 1099 eFile version. If you need to upgrade from the printed version, visit the
CheckMark website at www.checkmark.com.

Summary Report

The 1099 Summary Report Summarizes vendor payments by 1099 type. These totals can
be compared to Box 5 on Form 1096. Utilize this report to verify the accuracy of your
values before printing.

1. Under File, select Summary Report. Click Print.

int G Tools FontSizes Sort Window Help O 3 <O L @ Mon9:45PM Kristi b
® | Create Database L CheckMark 1099 Print 2017
Import...
Import Prior Year ™
"J CheckMark
Database Manager A 1099 Software
( Close Database Filter
EFile...
Summary Report
Mailing Labels

Print Forms for Recipient
Print Forms for Filing

uuunfe Company New Company Delete Company

Recipients 3 of 3 Filter MISC forms B All Status | ]

Jagger, Mick
Jett, Joan

Update Recipient New Recipient Delete Recipients Copy Recipient

Database: CheckMark 1099 Database - 1099 Year 2017
Path: /Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db
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Creating a file to eFile

1. Select the company you want to eFile for. You can select multiple companies if you
wish. For information on selecting multiple companies, see “Selecting Multiple
Com-panies” on page 19.

2. Select the recipients you wish to include. You can sort using the different forms or
choose All Forms from the drop down menu to select all recipients. For information
on selecting multiple recipients, see “Selecting Multiple Recipients” on page 38.

NOTE: You must choose at least one company, but if you do not choose any recipients,
all recipients will be included in the eFile.

You can sort the recipients by the Status drop down menu to group recipients as
Printed, Completed, Validated, Corrected and Void. For more information on
using the Status drop down menu and what Status means, see “Status” on page 36.

3. From the File menu, choose eFile...

ﬂm Tools Font Sizes Sort Window Help

® ® Create Database | CheckMark 1099 E-File 2017

Import...
Import Prior Year CheckMa rk...
1099 Software

Open Database g
Filter

Database Manager
Co Close Database

Summary Report
Mailing Labels
Print Forms for Recipient
Print Forms for Filing

L up pany | ( New Company | [ Delete Company |

| Open Database |

Recipients 10 of 10 (MISC forms (Al Status

Bower, Sammie
Comfort Climates

Evan's Pics
Free Range Chickens
Hill Maas

| Update Recipient | [ New Recipient | [ Delete Recipients | | Copy Recipient |

Database: CheckMark 1099 Database - 1099 Year 2017
Path: /CheckMark/1099/2017/CheckMark 1099 Database 2017.db
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4. In the pop-up window. Fill in all applicable fields.

¥ CheckMark”
h 1099 Software

Contact’s E-mad Address

Combined Fed/State Filing Program

Create E-Fle Now | | G

5. Optional: 1If you need more information on how to set up an E-file account, Click
the How to E-file button. A pop-up window with important links on how to first

apply, create a FIRE system account.

CheckMark
1099 Software
Follow these simple steps for E-Filing

1) Get Form 4419 - Application for Filing Information Returns Electronically (FIRE)
2) Create FIRE System Account
3) Verify you are ready to Login to your FIRE Account
4) Login to your FIRE Account
5) Send a TEST file!

| Close |

6. Once all the information is filled in, click the Create E-File Now button.
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7. If there are any errors in the transmitter information window, you will see a pop-up
window explaining what errors occurred.

CheckMark’
1099 Software

The following errors were discovered:
‘Transmitter Control Code: Must be 5 alpha/numeric characters.
Transmitter's TIN: Must be 9 digits.
Transmitter Name: Must be between 1 and 40 characters
Transmitter Company: Must be between 1 and 40 characters.

Transmitter's Mailing Address: Must be between 1 and 40 characters.
Transmitter's City: Must be between 1 and 40 characters.

Transmitter's State: Must be a valid U.S. state or territory (name or abbreviation).
Transmitter's Zip: Must be of form X000 or XO00X=X000K,

Contact Name: Must be between 1 and 40 characters.

Cambactle Muama Momsbiar: Momk ba of farmes VWV VYV VVVY ar YVV VVV VVVY c0d VVVVY

| Continue Anyway | ' Cancel |

8. Click Cancel to go back to the transmitter information window to correct any set up
errors. Or click Continue Anyway to proceed with saving the .txt file.

9. A Save as dialog box opens.

Fhe name: TZKEED .
Srve us type: Tt fldes () M

o Hde Felders [Come ] [ cameas |

10.  Enter a name for the file or use the default name if one is given. Save the file to a
location that is easy to find. The Desktop is an easy location to save the file to and
find it there later when you are ready to submit the file to the IRS FIRE system. Click
Save.
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Chapter 9
Backup and Restore

Making backups is critical to protecting your data. You should always keep current
backups. CheckMark 1099 allows you to easily backup your data to any external source for
safekeeping.

Backing Up Using the Backup Database Command

Using the Backup Database command within the program allows you to backup a
duplicate copy of the database. You can restore this database in case of computer failure or
to revert back to a previous database in case of an error in your current database. It is
recommended that you make current backup databases anytime you modify information.

NOTE: Only users with Admin privileges can backup and restore a database. For more
information on setting up Admin privileges, see “Setting up Users and Passwords” on

page 21.
L. Click on the Tools menu in the upper left hand corner of the screen and select Backup
Database.
m Font Sizes Sort Window Help D $ < L4 @) Mon9:51PM Kristil
® ®® Admin | CheckMark 1099 Print 2017
-
Restore Database CheckMark
Edit Printing Formats A 1099 SOftWa r
Compz Edit Page Setup Filter
ABC Company
Sample Co
XYZ Co
Update Company New Company Delete Company
Recipients 3 of 3 Filter MISC forms o] = All Status [T}
Jagger, Mick
Update Recipient New Recipient Delete Recipients Copy Recipient
Database: CheckMark 1099 Database - 1099 Year 2017
Path: /Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db
2. A Save In dialog box appears. Choose a destination you would like to save

the backup database to.
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3. A default name of backup (with the current date).db is given. Change the name of
the backup if you wish and leave the .db extension.

[ ] Create a Database Backup (All Companies in Database)

Save As: CheckMark 1099 Database 2017 Backu| @~

Tags:
< @ = E =, [ _Auto_Backups © Q
Favorites || CheckMark > [ 1095 > 2017 » [ _Configuration > I _Auto_Backups >
) N . ChkbkBal.pdf 11099 > ] _Backups >
& iCloud Drive class qu..licts.doc 7 Multiledger > 1 _Reports >
;/A\- Applications [ Coddington.docx [ Payroll > CheckM...017.db
5 Desktop - comcast12-12

Compar...ssay.doc
@ Documents costa project.doc

0 Downloads Costa Ri...ure.doc
Costa Ri...say.doc

Devices ] County..fice.docx

[T Kristi Fisher’s iBook G4

B

Format: 1099 Database Backup (*.db)

cancel | (ETCHN

New Folder

4. Click Save.
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Restoring Database using Restore Database Command

In case of computer failure, corruption or if you made a mistake and would like to
revert back to a previous database, the Restore Database command will open any
previous backups you have saved. You must have a Database created before you can
restore a backup.

L. Click on the Tools menu in the upper left hand corner of the screen and select Restore
Database.
nt File I FontSizes Sort Window Help D 3 <O @ WP Mon9:52PM Kristi
® 00 | Admin L CheckMark 1099 Print 2017
Backup Database -
CheckMark
Edit Printing Formats 1099 Software
Compz  Edit Page Setup Filter
ABC Company
Sample Co
XYZ Co
Update Company New Company Delete Company
Recipients 3 of 3 Filter MISC forms B All Status B

Dylan, Robert

Jagger, Mick
Jett, Joan

Update Recipient New Recipient Delete Recipients Copy Recipient

Database: CheckMark 1099 Database - 1099 Year 2017
Path: /Users/kristifisher/Documents/CheckMark/1099/2017/CheckMark 1099 Database 2017.db
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2. A Look in screen for Windows or Restore Database screen for Macintosh opens.
Browse to the location of the Backup Database file.

<

Favorites
E Al My Files
& iCloud Drive
/3 Applications
[ Desktop
@ Documents
© Downloads

Devices
[ Kristi Fisher's iBook G4
|=) Macintosh HD
[} KINGSTON

»

Media
‘1 Music
Photos

1095
1099
Multiledger
Payroll

Restore Database
Auto_Backups

2017 >

Enable: 1099 Database Backup (*.db)

3. Select the file and click Open.

__Configuration > _Auto_Backups > CheckM...4-17.db
_Backups >
_Reports >

CheckM...017.db

| v |

Cancel

Important: Restoring a database file will overwrite the existing .db file.
Restoring a database file is used in cases of the current file becoming
damaged or information being entered incorrectly into the current database.
Restoring from a previous database is faster than manually updating the

incorrect information.
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